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Introduction 
 
The JES Software Film Lab Software is comprised of several programs. This manual will 
describe the operation of the Cueing Station software called WINTAPE and the Re-Timing and 
Cueing Station software called WINCOMP. WINCOMP is an expanded version that contains all 
the cueing functionality of WINTAPE with the addition of Re-Timing functions. 
 
This manual will cover both the WINTAPE functions and the WINCOMP. The WINTAPE functions 
are all that is available for the WINTAPE user. For the WINCOMP user, it also covers the Re-
Timing functions available with WINCOMP and shows switching between the WINCOMP re-
timing view and the WINTAPE cueing view. The WINCOMP user has the complete functionality of 
cueing and re-timing. The headings of sections applying to WINCOMP will have [ WINCOMP ] 
appended to the heading. 
 
 
System Overview 
 
A quick overview of the system by outlining the system menus and the functions provided. There 
are three different menus. The Start Up menu displayed in the main window before data is loaded 
the WINTAPE data view menu displayed in cueing mode and the WINCOMP data view menu 
displayed in Re-Time mode. This final data view only appears with the WINCOMP program. 
 
Start Up Menu 
The main window contains the following menu headings; 

 
File  - File and Print operations 
 
Setup  - Program setup operations  
 
Tape  - Paper Tape Reader/Punch operation 
 
Database - Add jobs to database 
 
Convert  - Data Conversions 
 
Help  - Help Topics 
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File Menu 
The File menu allows you to: 
(1) Create a new job  
(2) Open an existing job from current versions or backup versions  
(3) Open a job from the most recently used file window 
(4) Restore last job from auto save file 
(5) Load and combine single color files to a composite job 
(6) Find jobs using the job control data base 
(7) Import files from other software systems 
(8) Control printer setup 
(9) Exit the program. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Refer to the following sections for details on each File menu function. 

New – Create New Job  
Open  - Open Job from File menu 
Restore – Restoring Files 
Load Backups – Open Backup Files 
Combine Files – Combining Files 
Find File – Open Job from the Job Database 
Import File –Importing Files 
Print Setup – Setting Printer Options 
Most Recently Used File Window – Open Job from Most Recent Use (MRU) Window 
Exit – Quit Program 
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Setup Menu 
The Setup menu allows you to:  
(1) Set the communications parameters for the Paper Tape Reader/Punch and the DACC 

controller   
(2) Set the format parameters for the current job  
(3) Set the current synch position 
(4) Enable or disable the encoder control   
(5) Set the default directory for all file operations  
(6) Set the default directory for the database build operation  
(7) Set user or site preferences 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Reference the following sections for details on the setup menu functions. 
Communications – Set Communications 
Format – Set Format 
Set Synch – Set Synch 
Encoder Enable – Enabling the Encoder 
Default Directory – Set Default Directory 
Root File Directory for DB Build – Set Root File Directory for Database Build 
Preferences – Set Preferences 
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Tape Menu 
The tape menu is used for: 
(1) Loading jobs from paper tape 
(2) Punching paper tape from a loaded job 
(3) Reading paper tape to file for special purpose functions such as debugging  
(4) Viewing a picture of the paper from a saved tape file, a special function for debug purposes. 
 
 
 
 
 
 
 
 
   
 
 
 
Reference the following sections for details on the tape menu functions. 
Read Paper Tape – Loading Jobs from Paper Tape 
Punch Paper Tape – Saving Jobs to Paper Tape 
 

Data Base Menu 
The database menu is used to:  
(1) Add new jobs into the job control database 
(2) Build the Database 
 
 
 
 
 
 
Reference the Adding Jobs to the Database and Building the Database sections. 

Convert Menu 
The Convert menu is used to create test data. 
 
 
 
 
 
   
Reference the following sections for details. 
Cynex  - Creating Cynex Data. 
Wedge - Creating Wedge Data. 

Help Menu 
The help menu is used to provide help on using the program. Click on Help Topics or Press F1 
for help. 
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WINTAPE ( Cueing Data View ) Menu 
Once data has been loaded, the WINTAPE cueing data view screen appears, and the main menu 
is now expanded to include items pertaining to operations on the loaded data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Examining this menu shows that the File menu, and the Convert menu have been expanded to 
add new functions and the root menu is now expanded to include Utilities, Edit, View and 
Window. The menu changes are discussed in the following sections. 

File Menu 

The File Menu now includes Save and Save As, Print and Print Preview. 
Refer to the following sections for details on the new File menu functions. 
Save, Save As – Saving the Job  
Print, Print Preview  - Print Lists of Job 
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Convert Menu 
The Convert menu now includes Reverse Data, YCM to RGB Convert and Robot to RGB 
Convert. 
 
 
 
 
 
 
 
 
 
Refer to the following sections for details on the Utilities menu functions. 
Reverse Data - Reverse Data  
YCM to RGB Convert - YCM to RGB Convert 
Robot to RGB Convert - Robot to RGB Convert 

Utilities Menu 
This menu presents functions that are used to make overall updates to the data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Refer to the following sections for details on the Utilities menu functions. 
FCC Adjust - FCC Adjustment  
RGB Adjust  - RGB Adjustment 
Append Roll B to A - Appending Rolls 
Loops Append - Loops Append 
Swap Rolls - Swap Sections of Roll 
Remove Duplicates - Remove Duplicates 
Find Shortest Scene -  Shortest Scene Check 
Verify Rolls - Compare Rolls for Differences 
Clear Color Samples - Color Samples Table 

Edit Menu 
The Edit menu sets options for data editing. 
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The Edit Menu items shown and the associated accelerator keys are used to enable or disable 
edit fields. Fields may also be enabled or disabled for editing by checking or unchecking the 
Check Box above the edit field column.  Refer to Enabling and Disabling Input Fields in the 
Edit Key Reference section. 
The Enable Append Scenes enable and disables Append mode. Refer to Append Mode in the 
Edit Key Reference section. 
Re-Time is a special editing mode in WINTAPE that allows color updates to be done as plus and 
minus. This is not the same as Re-Timing in WINCOMP. 
Refer to Re-Time Mode in the Edit Key Reference section. 
 

View Menu 
The View menu sets options the data view display. 
 
 
 
 
 
 
 
 
The Color Samples table and the Scene Description tables are enabled from this menu. 
 
WINCOMP ( Re-Timing Data View ) Menu 
Once data has been loaded, the WINCOMP re-timing data view screen appears, and the main 
menu is now expanded to include items pertaining to operations on the loaded data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Examining this menu shows that the File menu has been expanded to add new functions and the 
root menu is now expanded to include Edit, Utilities, View and Window. The menu changes are 
discussed in the following sections. 
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File Menu 
The File Menu now includes Update Colors, Clear Color Updates, Save and Save As, Print and 
Print Preview. 
Refer to the following sections for details on the new File menu functions for the Re-Timing view. 
Update Colors – Update Colors [ WINCOMP ] 
Clear Color Updates –Updates [ WINCOMP ] 
Save, Save As – Saving the Job [ WINCOMP ] 
Print, Print Preview  - Print Lists of Job [ WINCOMP ] 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Edit 
The edit menu sets options and functions for Re-Time editing. 
Refer to the Edit Key Reference [WINCOMP] and Editing [WINCOMP]. 
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Utilities 
The utilities menu provides functions that provide overall updates to Re-Time data. 
Refer to the following sections for details; 
RGB Adjust – Edit [ WINCOMP ] - RGB Adjustment 
Find Shortest Scene – Find Shortest Scene 
Clear Color Samples – Color Samples 
 
 
 
 
 
 
 

View 
The view menu has two additional items to the view menu for the cueing view. These are Expand 
View and WinTape. Expand View / Shrink View will add or remove columns to the view. WinTape 
or the ALT / 1 key will switch to the WINTAPE cueing view. ALT / 2 switches back to the 
WINCOMP view. 
 
 
 
 
 
 
 
 
 
 
 

Window 
The window menu is also used to switch between the cueing view and the re-time view.
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Program Setup 
Setup Functions 
The setup section is used to set program initialization parameters, job settings and user 
preferences. Use the Setup menu to select the various setup functions. 

Set Communications 
This function is used to setup the serial communications ports and is opened using the 
Setup/Communications menu function. The program uses two serial communication ports, one 
for the Paper Tape Reader/Punch and the other for the DACC control unit that controls encoder 
input counts and footswitch inputs. The communication ports are assigned to each device from  
COM1 and COM2. If a Paper Tape Reader/Punch is to be used on this station then the baud rate  
and the hardware handshake needs to set here. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set Format 
The film format is set by this function called by the Setup/Format menu or the CTRL + F key. 
This is used to control settings for the current job, such as 16 or 35 mm, foot and frames or 
frames only, color or black and white, and single or dual roll. Single or dual roll can also be set 
from the Dual check box on the job screen. 
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Set  Synch 
To set the encoder count, select this function from the Setup/SetSynch menu and enter the foot 
and frames or frames for frames only mode. 
 
 
 
 
 
 
 
 
 
 
 
 

Set Default Directory 
The default directory is the directory where the File Open and File Save dialogs will be set 
initially. This can be a directory on a local drive or a network drive. This function is called from the 
Setup/Set Default Directory menu. 
 
 
 
 
 
 
 
 
 
 
 
 

Set Root File Directory For Database Build 
This directory is the root directory used by the database build function. This can be a directory on 
a local drive or a network drive. The database build is used to add files to the database from 
existing directories. The build function is not required when the database is updated with each file 
save. This function is called from the Setup/Set Root File Directory for DB Build menu. 
 
 
 
 
 
 
 
 
 
 
 
 

Enabling the Encoder 
To enable the encoder, Click on the Setup/Encoder Enable menu. If it is enabled, it may be 
disabled by Clicking on the Setup/Encoder Disable. 
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Set Preferences 
The user preferences or site preferences can be set from this function which is called from the 
Setup/Preferences menu. 
 
Minimum Scene Length is the minimum distance in frames allowed between scenes. An error 
message is generated for scenes that are shorter than this distance. 
 
Fade Too Close Distance is the minimum distance in frames allowed between scenes when a 
scene has an effect.  
 
Use Scene Desc with RGB Samples is a preference for configuring the Color Samples view to 
include or not include Scene Descriptions/ Cut backs with color samples, ( See Color Samples ). 
 
FCC Tapes Contain First CUE is set to control the format of FCC paper tapes as to whether the 
first cue appears on the tape or not. 
 
Use Cut Backs is a user preference that determines whether usage of HFC style cutbacks are 
desired or not, ( See Scene Descriptions and Cutbacks ). 
 
Scene Numbering Style is a preference that determines how scenes are numbered in dual roll 
mode. In Roll numbering scenes are to numbered by roll independent of overall order. In Overall 
numbering scenes are numbered according to the overall order in the dual roll view. 
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Job Control 
This section deals with setting up jobs, printing jobs and saving jobs. 
 
Create New Job 
 
To create a new job, use the menu Command File/New or the keyboard keys CTRL + N. This will 
present the File Header dialog, for entry of Job information such as Subject, Client, Job Number 
and etc. The header information may be entered at this time or entered later when the job is 
saved. The information from the previous job is retained for reuse in case it pertains to the current 
job also. Press the CLEAR button if new information is to be entered. File format is normally set 
to the native WinTape format but can be set to DOS TapeStation for compatibility with the DOS 
J.C. Cooper Tape Station program, or to ®Bremson for compatibility with the Bremson program. 
Only use these options when you want to carry the saved data back to one of these systems. 
 
If your Lab is using the WinTape Database system for tracking and retrieving jobs, then the Job 
information can be filled in by; 
1. Selecting Subject from the Subject drop down list. 
2. Selecting Job Number from Job Number drop down list. 
3. Selecting Client from the Client drop down list. 
After selecting one of these fields the other two are retrieved from the database. 
If the job has not entered in the database, press the ADDJOB button to add this job to the 
database. See Add Jobs to the Database Section for further details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If there is a job currently open, ( See Closing a Job ), you will be prompted as follows; 
“Roll A nn scenes – Overwrite Loaded Data”, YES/NO. (where nn is number of scenes) 
and if there is Roll B data, 
“Roll B nn scenes – Overwrite Loaded Data”, YES/NO. 
If you answer NO, you will be returned to the current job and the new job request is cancelled. 
If you answer YES the current job is closed and the new job is presented for data entry. 
If the current job has updates, then you will be prompted to save the data before the new job is 
started, ( See Saving the Job ). 
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The new job is opened as shown below. ( See Editing for full details on keyboard functions  for 
entering data).  
 
 
 
 
 
 
 
 
 

Key Board Mode 
 
The following section describes the methods to use for keyboard entry of new data without using 
the encoder and foot switches. Since this mode operates a little differently from the normal 
footswitch operation, it requires some explanation. 
Make sure the Append check box is checked so that when the last scene is completed, a new 
scene is inserted automatically. When you reach the last scene you may have to delete the 
automatically inserted scene, or turn off Append Mode prior to completing the last scene. 
If this is a Dual Roll then there are two methods that can be used to enter new scenes. 
Method 1: 
Enter All A roll scenes in Single Roll Mode, then switch to Dual Roll Mode, (click on Dual check 
box), disable all A roll fields (uncheck each box for FCC, DESC, RGB and FADE), and then enter 
the B roll scenes. 
Method 2: 
Switch to Dual Roll Mode,(check the Dual and Append boxes), and with all fields you wish to 
enter enabled, enter the A roll and B scenes as you go. In this mode each time you complete a 
scene on the A side and new scene is inserted on the B side with the same FCC as the A side. 
Change this FCC if it is not the same. To insert the new scene on the A side press SHIFT/ENTER 
to complete the last field of the last scene. Each time a scene is completed on the B side a new 
scene is inserted on the A side. To insert the new scene on the B side press SHIFT/ENTER to 
complete the last field of the last scene. 
ENTER inserts a new scene on the other side in a checkerboard fashion. 
SHIFT/ENTER inserts a new scene on the same side. 
 

Footswitch Mode 
 
Make sure Append mode is enabled. For a dual roll job enable Dual mode otherwise, leave it 
disabled. 
Roll the film to the beginning of the scene and press the footswitch A to insert a scene in the A 
roll, or press the footswitch B to insert a scene in the B roll. If the encoder FCC is not greater 
than the last scene or Append mode is turned off, then pressing the footswitch  A or footswitch 
B causes the FCC of the current A or B scene to be overwritten. 
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Loading Jobs from Paper Tape  

Read Paper Tape 
To read a paper tape use the Tape / Read Paper Tape menu function or press CTRL + R. 
In the Reader Paper Tape dialog select Roll A or Roll B as the destination of the data. Select the 
Type of Tape to read. Reading two tapes in succession, selected as FCC + RGB or RGB + FCC,  
saves the extra steps involved in two separate Read Tape operations. 
Press OK. Press OK again and start the Paper Tape reader. 
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Open Existing Job 
Existing jobs can be opened in several ways. 

Open Job from Most Recent Use (MRU) Window. 
If this job has been recently opened and is visible in the MRU window on the File Menu, clicking 
on that item in the MRU window can open it.  
A sample of the MRU window showing recently opened files is shown by the figure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open Job from File Menu. 
To open an existing job, use the menu File/Open function or the keyboard accelerator keys 
CTRL + O. This will bring up the File Open dialog as shown. The Look in: window will initially be 
set to the same folder as set by the Default Directory setup, ( See Set Default Directory ). If the 
preview check box is checked and a file is selected in the file view window, the file header 
information will appear in the preview window. If the file is a single roll file then check A Roll or B 
Roll as required. A dual roll job may be opened from two single roll files by loading the A roll and 
then the B roll. If the file is a dual roll file then both A and B will be loaded in one operation. 
Select the required file so that the filename appears in the File name: window and click on the 
OPEN button. 
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The File Header information is shown in the File Header dialog, if the header information is to be 
changed, it can be updated during the File Save process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Prints of the change history are available under the Job Reports section. To produce a history 
record it is necessary to keep a baseline version of the data before changes are made for 
comparison with the current data. The first time a Job is opened that version of the data is saved 
automatically as the history baseline. Opening the job after that presents the following dialog. 
Pressing the YES button allows resetting the baseline to the current data file being opened. 
Pressing NO keeps the baseline previously set. 
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Finally the scene data view is presented for the opened file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Editing of the scene data is described in the Editing Section. 

Open Job from the Job Database 
Use the File/Find File menu item and select one of, Find By Subject, Find By Job Number, Find 
By Client or Find From All. The following example shows the results of a Find by Subject request. 
The available subjects are listed in the Select SUBJECT dialog. 
Select the required subject and click on the OK button or double click the required subject.   
 
 
 
 
 
 
 
 
 
 
This brings up the SELECT REEL FROM SUBJECT dialog. 
 
 
 
 
 
 
 
 
 
Select the required job by REEL double click or click on the OK button.   
This brings up the Roll Selection dialog to choose whether the data is to be loaded as a Roll A or 
Roll B data.  
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From this point the process is the same as the previous Open process. Find by Job Number, Find 
by Client or Find from All, are similar to Find by Subject. 

Open Backup Files 
Select File/Load Backups from the File menu, which opens a submenu of backup choices, First 
Backup and Second Backup. Each time a file is saved the previous file becomes backup 1 or 
the first backup file. The backup 1 file if there is one becomes backup 2 or the second backup. 
Choosing to load the First Backup will present a File Open dialog similar to the normal file open 
except the files to open are the *.bk1 files. Similarly choosing to load the second backup will 
present a file open dialog for *.bk2 files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Restoring Files 
Approximately every minute the current job is automatically saved to a restore file. If the computer 
crashes or the power fails, the last job in progress can be restored if the File/Restore function is 
performed as the first thing when the WinTape program is restarted. If another job is opened 
before the Restore function is performed the next AutoSave could overwrite the previous restore 
file. 
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Importing Files 
Files may be imported from ®HFC, ®Bremson, ®BHP or the J.C. Cooper Tape Station files. 

Importing HFC Files 
Select File/Import from the File menu. This opens a submenu of file types that can be imported, 
BHP and HFC. Select HFC. This opens a dialog box to set the directory location of the HFC files 
to be imported.  The directory location can be entered directly in the Select Directory edit window 
or click on the BROWSE button to find the location by browsing. The directory location can be on 
the local drives or on a network drive. 
 
 
 
 
 
 
 
 
 
 
 
 
Press the OK button to open a list of jobs found in this directory.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The list shows Job, Subject and Reel. Select the Job to import and double click it or press the 
OPEN button.  
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The open process from this point is the same as for a normal File/Open process. Finally the 
imported HFC data is shown in the scene editing view. 

Importing ®BHP Files 
Select File/Import from the File menu. This opens a submenu of file types that can be imported, 
BHP and HFC. Select BHP. This opens the standard file open dialog box in the same manner as 
for WinTape files, except that the file type is *.bhp. The file open procedure is the same as 
opening a native WinTape file. The imported scene data is presented in the scene editing 
window. 

Importing JC Cooper or ®Bremson Files 
Bremson and JC Cooper files are imported by using the standard File/Open and setting the file 
type as Bremson or DOS for JC Cooper files. 
 
Combining Files 
Combining files is used for converting three single color files, (RGB files or YCM files) to a single 
composite file. This process saves punching three separate tapes, and then reading them back 
and combining the data. Select File/Combine Files which presents the submenu for choosing 
RGB or YCM as the input file type. Click on one of these choices and the Select File 1 dialog is 
presented. 

Select RED or YELLOW 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Find the RED file if RGB files, or YELLOW if YCM files. This can be done using the BROWSE 
button or the FIND BY SUBJECT button to find from the Job database, 
( See Open Job from the Job Database for details on using FIND BY SUBJECT. After the file 
name shows in the FILE edit window press the Next button. 
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Select GREEN or CYAN 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Find the GREEN file if RGB files, or CYAN if YCM files. After the file name shows in the FILE edit 
window press the Next button. 

Select BLUE or MAGENTA 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Find the BLUE file if RGB files, or MAGENTA, if YCM files. After the file name shows in the FILE 
edit window press the Finish button. After pressing the Finish button the open proceeds through 
the same steps as the normal open process until the scene data window appears with the 
combined data loaded from the three files. 
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Adding Jobs to the Job Database 

Add New Job 
Add a New Job to the database, can be invoked from the database menu or from the ADD JOB 
Button on the File Header information dialog. This function is performed in three steps, add a 
SUBJECT, add a CLIENT and add a JOB NUMBER to the database to define this job. 
 
Step One 
If it is a new subject, input the Subject name in the Subject edit box and Press ADD NEW.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the Subject already exists in the database but under a different job number Press SELECT 
EXISTING, and select the subject from the list and double click it or press OK. 
 
 
 
 
 
 
 
 

 

 

 

 

 
 
Pressing either the ADD NEW button or the SELECT EXISTING and choosing an existing subject 
completes step one and the NEXT button becomes enabled. Press NEXT. 
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Step Two 
If it is a new client, input the Client name in the Client edit box and Press ADD NEW.  
 
 
 
 

 

 

 

 

 
If the Client already exists in the database but under a different job number Press SELECT 
EXISTING, and select the client from the list and double click it or press OK. 

 

 

 

 

 

 

 

 

 
 
 
Pressing either the ADD NEW button or the SELECT EXISTING and choosing an existing subject 
completes step two and the NEXT button becomes enabled. Press NEXT. 
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Step Three 
 
 
Input the new job number into the job number edit box and Press ADD NEW. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press FINISH and the new JOB NUMBER with SUBJECT and CLIENT will be in the database. 
Once the job has been added to the database, the File Header information may be completed by 
selecting the job number. Client and Subject number are then added to the header information 
automatically from the database. 
 
The Add Job function introduces a list of SUBJECTS, a list of CLIENTS and a list of JOB 
NUMBERS that can be associated with jobs as they are worked on. The job files are put into the 
database at the time that the job is saved. The information in the File Header of the saved job is 
used to identify the saved job. The Add Job lists of SUBJECTS, CLIENTS and JOB NUMBERS is 
used to assist in adding the File Header information. 
 
It is important to have a consistent naming scheme for SUBJECTS, CLIENTS and JOB 
NUMBERS. The database will consider to names that are spelled differently to be different. That 
is “WARNER BROS”, “WB” and “WARNER BROTHERS” are three different clients as far as the 
database software is concerned. The ADD JOB function is intended to allow names to be added 
once and then when the File Header information is added, the existing names in the database are 
used from the pulldown lists.
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Building the Database 
Normally this function is not required, since jobs are added to database as you create and save 
them. However to add jobs that are not in the database, because they existed before the 
database was introduced you can use this function. 
 
If you have a collection of files that are not in the database, because you were not using the 
database feature when the files were built, then you can use the database build function.This 
function is used to add existing jobs into the database from the file location specified in the Set 
File Location for DB Build dialog shown below. It will search this directory and all its 
subdirectories for WINTAPE files and add them to the database REEL table. This function does 
not add to the SUBJECT table, CLIENT table or the JOBNUMBER table. 
 
Normally by using the Add Job Function you create entries in the SUBJECT, CLIENT and 
JOBNUMBER tables of the database. Then when a job is saved the information in the File 
Header is used to put the job in the database REEL table. This allows a job to be located by using 
the File Find function. You can search the database for jobs by SUBJECT, by CLIENT or JOB 
NUMBER. 
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Job Reports 

Setting Print Options 
The File / Print Setup menu is used to set the print list options and then the Printer Setup. Print 
list can be set as single, double or triple spaced. Grid lines in the lists can be shown or turned off. 
Select the desired options and Press OK. 
 
 
 
 
 
 
 
 

 

 

 
The print setup is performed using the standard Windows printer setup dialog. 
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Selecting Type of Print List 
Invoke the File / Print or File Print Preview menus, to produce the print list selection dialog. Print 
preview allows view the print list before sending it to the printer. Select the type of print desired 
from the following and Press OK. 
Single Roll – ROLL A 
Single Roll – ROLL B 
Dual Roll 
Print History – ROLL A 
Print History – ROLL B 
Color Changes – ROLL A 
Color Changes – ROLL B 
Color Changes History – ROLL A 
Color Changes History – ROLL B 
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Single Roll List 
The single roll list displays the data of an A roll or B roll as selected by list type. A single roll print 
list is shown for Roll A. A single roll list of a dual roll job will number scenes in the order as 
specifies the Setup / Preferences section, that is Number by Roll or Overall Numbering. 
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Dual Roll List 
The Dual Roll list shows roll A and roll B in side by side view. A Dual Roll print list is shown. 
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Print History 
The History list shows the color history comparing the current file data with the first backup data 
and the second backup data. The History list is in the order of CURRENT, BK1 and BK2 from left 
to right. Since backups are cycled with each save of the data, the History list will only reflect the 
changes relative to each save. 
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Color Changes 
The Color Changes list compares the current data in memory to the Baseline file data. The 
Baseline data is independent of the number of times the data has been saved. Each time the job 
is opened you can set this data as a new baseline or you can preserve the baseline as previously 
designated. When the data is first entered as in, Create New Job, a Baseline is established at 
that point. That will remain as the Baseline until on a subsequent open you declare a new 
Baseline. The order of the list is BASELINE to CURRENT MEMORY from left to right. 
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Color Changes History 
The Color Changes History list compares the current data from the last save to the Baseline file 
data.  The difference between the Color Changes list and the Color Changes History list is that 
the first compares the current data in memory prior to saving to the Baseline, whereas the latter 
compares the current file data from the last save to the Baseline data. The order of the list is 
BASELINE to CURRENT FILE from left to right. 
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Job Reports [ WINCOMP ] 
The print list selection is the same as for the WINTAPE view. The only lists that are different from 
the WINTAPE view are the Color Changes list and the Color Changes History list  

Color Changes 
The Color Changes list compares the current data in memory to the Baseline file data. The 
Baseline data is independent of the number of times the data has been saved. Each time the job 
is opened you can set this data as a new baseline or you can preserve the baseline as previously 
designated. When the data is first entered as in, Create New Job a Baseline is established at that 
point. That will remain as the Baseline until on a subsequent open you declare a new Baseline. 
The order of the list is BASELINE to CURRENT MEMORY from left to right. 
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Color Changes History 
The Color Changes History list compares the current data from the last save to the Baseline file 
data.  The difference between the Color Changes list and the Color Changes History list is that 
the first compares the current data in memory prior to saving to the Baseline, whereas the latter 
compares the current file data from the last save to the Baseline data. The order of the list is 
BASELINE to CURRENT FILE from left to right. 
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Saving the Job 

Save Files 
To save the job use File / Save or CTRL + S to save the file under the same filename or File / 
SaveAs to save the file under a different filename. If you have made changes and use File / 
Close, you will be prompted to save the file. 
 
The Save File Header information dialog box appears as result of the Save operation. If the 
Header information has not been set yet you need to enter it at this point, or if it is already 
entered you may change it. 
 
The information from the previous job is retained for reuse in case it pertains to the current job 
also. Press the CLEAR button if new information is to be entered. File format is normally set to 
the native WinTape format but can be set to DOS TapeStation for compatibility with the DOS J.C. 
Cooper Tape Station program, or to ®Bremson for compatibility with the Bremson program. Only 
use these options when you want to carry the saved data back to one of these systems. 
 
If your Lab is using the WinTape Database system for tracking and retrieving jobs, then the Job 
information can be filled in by; 
(1) Selecting Subject from the Subject drop down list. 
(2) Selecting Job Number from Job Number drop down list. 
(3) Selecting Client from the Client drop down list. 
After selecting one of these fields the other two are retrieved from the database. 
If the job has not been entered in the database, Press the ADDJOB button to add this job to the 
database. See Add Jobs to the Database Section for further details. 
 
Press OK when header information is completed. 
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If the save is a Save As operation, the File Save dialog appears with the file save path set at the 
Default Directory. Enter the filename in File Name edit box.  If single roll, Select Roll A or Roll B to 
direct which data is to be saved. Press Save and when the save is completed a message box will 
confirm the number of scenes saved successfully. You will be prompted with the option of saving 
the data to a floppy, answer YES or NO. 
 
Saving a file automatically creates backups of the original data file if one exists. The original file 
becomes the first backup file ( with file extension of BK1 ). If a BK1 file exists, it becomes the 
second backup ( with file extension of BK2 ). If a BK2 file exists, it is removed. 
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Saving the Job [ WINCOMP ] 

Add Updates 
To apply Color Updates select File / Update Colors or Press CTRL + U. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Color Updates are applied and the Color Updates are cleared. 
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Save Files 
When the data is saved if the Color updates have not been applied then the message box 
appears giving the choice of applying the Color Updates prior to the save or saving the Color 
Updates and saving the file without the updates applied. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the appropriate option and Press OK. The remainder of the save is the same as in the 
WINTAPE cueing view. 
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Saving Jobs to Paper Tape  

Punch Paper Tape 
To punch a paper tape from the current data select the Roll data to use and select the Type of 
Tape to punch. For color separations tapes set the color options field. Set the options field for 
Heads or Tails, Loops as required. Output will be to the Punch. For extended tape header 
information check Extended Header. Turn on Tape Punch and Press OK when Ready. 
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JOB PROCESSING 
Editing 

Edit Key Reference 
The following keys are used for scene editing functions. To edit a field in the scene the data in the 
field must be highlighted. 
 
Edit Control Keys 
 
TAB or ENTER 

The TAB or ENTER key moves  to the next field that is enabled for input, 
skipping over input disabled fields. 

 
SHIFT/TAB 

  The SHIFT/TAB key moves to the previous input enabled field, skipping over 
fields that are disabled. 

 
UP ARROW 

 The UP ARROW  Î  key moves to previous scene remaining in the same input 
field. When the first scene is reached, the UP ARROW is ignored. 

 
DOWN ARROW 

  The DOWN ARROW Ï  key moves to next scene remaining in the same input 
field. When the last scene is reached, it will not move any further. A new scene is 
not appended at the end.  

 
SHIFT/ENTER 

               The SHIFT/ENTER key moves to the first input enabled field of the next scene.  
When the last scene is reached, if APPEND mode is enabled a new scene is 
appended following the last scene. If APPEND mode is disabled the 
SHIFT/ENTER key is ignored in the last scene. 

 
LEFT ARROW 

When two rolls are loaded the LEFT ARROW Ì  key moves from the B Roll to 
the A Roll. 

 
RIGHT ARROW 

When two rolls are loaded the RIGHT ARROW Í  key moves from the A Roll to 
the B Roll. 

PAGEUP 
  Scrolls display up one page. 
PAGEDOWN 
  Scrolls display down one page. 
HOME 
  Move display to scene 1. 
END 
  Moves display to last scene. 
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Scene Description Keys 
CTRL/1 to 
CTRL/0 

When the scene description field is highlighted, the keys CTRL/1 to CTRL/0 will 
enter the scene description from the scene description table. CTRL/1 retrieves 
the scene description #1 from the table and CTRL/2 retrieves scene description 
#2 and etc. 

 
SHFT/1 to 
SHFT/0 

When the scene description field is highlighted, the keys SHFT /1 to SHFT /0 will 
enter the scene description from the scene description table. SHFT /1 retrieves 
the scene description #11 from the table and SHFT /2 retrieves scene description 
#12 and etc. 

 
F5  

When the scene description field is highlighted, the F5 key is used to store the 
current scene description into the scene description table. 

 
Color Keys 
‘A’ to ‘N’  

When the RGB field is highlighted, the keys ‘A’ to ‘N’ are used to retrieve the 
color data from the sample table at the corresponding sample table position. 

 
F4 

When the RGB field is highlighted, the key F4 is used to store the current color 
data to the sample table.    

F11 
When the RGB field is highlighted, the key F11 is used to copy the color data 
from the previous scene to the current scene.    

F12 
When the RGB field is highlighted, the key F12 is used to copy the color data 
from the scene two back from the current scene to the current scene.    

 
 
Scene Insert 
 
INSERT   

The INSERT key is used to insert a scene following the current scene. The FCC 
is automatically set to one frame greater than the current scene. The actual FCC 
can then be entered. 

 
Scene Delete 
 
DELETE 

The DELETE key is used to delete the current scene. 
 
 

Enabling and Disabling Input Fields 
The Input fields of each scene are FCC, SCENE DESC, RGB and FADE. Each field may be 
enabled or disabled for input. The Scene Header Area has an input enable check box as follows; 

[ X ]  FCC     [ X ] DESC       [ X ] RGB    [ X ] FADE 
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When the box is checked (input enabled), the field can accept input. When the box is not checked 
(input disabled), the column for the field is grayed and the cursor skips past that field. To change 
the check box move the mouse cursor to the check box and LEFT CLICK the mouse. 
 
 

FCC Input 
To input or edit the FCC field, the field must be enabled and the data highlighted. If the data is not 
highlighted click on the field to highlight it. 
 
FCC data is in the format of 9999.99 where 9999 is feet and 99 is frames. 
ENTER feet, followed by ‘.’ , then frames. 
 
The FCC, 123 feet and 12 frames, is shown as 123.12. 
 
Example to enter 123.12, enter ‘1’, ’2’, ’3’, ’.’, ’1’, ’2’ , followed by ENTER to complete the field.  
 
To enter frames without changing the feet, enter a ‘.’ to skip over the feet and then enter frames. 
 
Example to change the FCC 123.12 to 123.8 enter ‘.’ to skip over the feet then ‘8’ followed by 
ENTER to complete the field. 
 
 
 

Scene Description Input 
To input or edit the Scene Description field, the field must be enabled and the data highlighted. If 
the data is not highlighted click on the field to highlight it. 
 
Enter the scene description up to 12 characters followed by ENTER to complete the field. 
 
Example To enter the scene description “boy”,  enter ‘b’, ‘o’, ‘y’ followed by ENTER to complete 
the field. 
 
Scene descriptions may also be copied from the Scene Description Table, Refer to Scene Editing 
Key Reference. 
 
When the scene description field is highlighted, the keys CTRL/1 to CTRL/0 and SHIFT/1 to 
SHIFT/0 will enter the scene description from the Scene Description Table. 
 
When the scene description field is highlighted, the F5 key is used to store the current scene 
description into the scene description table. 
 
To view the Scene Description Table use the View Pull Down Menu or enter ALT/V followed by 
‘D’. 

RGB Input 
To input or edit the RGB field, the field must be enabled and the data highlighted. If the data is 
not highlighted click on the field to highlight it. 
 
RGB data is in the format of 99.99.99 where 99 is the color RED, GREEN and BLUE. 
 
The colors RED 31, GREEN 32, BLUE 33 are shown as 31.32.33. 
Example To enter 31.32.33, Enter ‘3’, ‘1’, ‘3’, ‘2’, ‘3’, ‘3’ followed by ENTER to complete the field. 
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To enter a single digit color use the ‘.’ to complete the color. 
Example 00.00.00 is entered as ‘0’, ‘.’, ‘0’, ‘.’, ‘0’ followed by ENTER. 
 
Colors may also be copied from the Color Samples Table. Refer to Scene Editing Key Reference. 
To view this table use the View Menu or enter ALT/V followed by ‘C’. 
 
When the RGB field is highlighted entering a letter ‘A’ to ‘N’ will copy the Color Sample Table 
entry to the RGB field, 
The F4 key will store the current color data to the Color Samples Table. 

Fade Input 
To input or edit the Fade field, the field must be enabled and the data highlighted. If the data is 
not highlighted click on the field to highlight it. 
 
Fades are entered as a value from 0 to 128. Acceptable fades are 16,24,32,64,96 and 128. 

Append Mode 
The Scene Data Header has an Append Mode check box. Click the Append mode box to enable 
or disable APPEND mode. 
 

[ X ] APPEND 
 
If APPEND mode is enabled, Pressing ENTER to complete the last scene, causing automatic 
insertion of another scene with an FCC one frame greater than the previous last scene. Update 
the FCC to show the actual FCC for this scene. 

Re-Time Mode 
In Re-Time mode Num Lock and Scroll Lock must be on, all edit fields are disabled except the 
RGB color fields. Use the Numeric keypad to update colors as follows; 
 
NUMERIC KEYPAD 
 
 [ 4 ]  [ 5 ]  [ 6 ] 
         +1 RED            +1 GREEN        +1 BLUE 
 
 [ 1 ]  [ 2 ]  [ 3 ] 
         -1 RED            -1 GREEN        -1 BLUE 
 
 [ 0 ]  [ . ]  
        -1 DENS           +1 DENS      
 
 
 
Press ENTER to Updates Colors. 
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Editing [WINCOMP] 

Edit Key Reference 
 
NUMERIC KEYPAD 
 
 [ 4 ]  [ 5 ]  [ 6 ] 
         +1 CYAN            +1 MAGENTA  +1 YELLOW 
 
 [ 1 ]  [ 2 ]  [ 3 ] 
         +1 RED            +1  GREEN        +1 BLUE 
 
 [ 0 ]  [ . ]  
        -1 DENS           +1 DENS      
 
 
To add updates in the Re-Time view use the keys as shown from the numeric keypad and press 
ENTER when the scene updates are completed.
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Editing Utilities 

FCC Adjustment 
The FCC adjust function is used to alter FCC’s on all scenes beginning with the specified Start 
Scene up to and including the End Scene. The adjustment is entered as plus or minus foot and 
frames. In frames only mode the adjustment is in frames. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RGB Adjustment 
The RGB adjust function is used to alter colors on all scenes beginning with the specified Start 
Scene up to and including the End Scene. The adjustment is entered as plus or minus Red, plus 
or minus Green and plus or minus Blue. The minimum and maximum allowable adjustments are 
shown. Normally scenes with zero colors are not adjusted.  To override this check the Enable 
Adjust of ( 0,0,0 ) Lites Check Box. 
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Appending Rolls 
To append rolls, load the first file as roll A, load the second file as roll B and use the Append Roll 
B to A function.  This will append roll B to the end of Roll A. This process may be repeated as 
many times as required, by reading another file into roll B and using the Append Roll B to A 
function again. 

Loops Append 
Loops Append is used to append a given file to itself a number of times. 
 
Enter the number of times to append, for N loops enter N-1 appends. Press OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The created loop data is shown below. 
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Swap Sections of Roll 
To swap a section of scenes between rolls use the Swap Roll function. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the FCC of the beginning of the swap section and the FCC of the ending section, Press 
OK.  The results of the swap are shown below. 
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Remove Duplicates 
Remove Duplicates will remove adjacent scenes will the same colors. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The number of duplicates found is identified. Press ENTER or Click on YES to perform the 
operation. The modified data after removal of duplicate scenes is shown below. 
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Shortest Scene Check 
To perform a shortest scene check, use the Find Shortest Scene function. The result gives 
shortest scene, total fades and total length of each roll. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Compare Rolls for Differences 
To check data before and after an operation to see if the data is identical use the Verify Rolls 
function. For example to check a punched tape, load original file into roll A and read the paper 
tape of the same data into roll B and perform the Verify Roll function. The data should be 
identical, if not there is an error in punching the data. 
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Reverse Data 
Reverse Data produces a tails version of the data and overwrites the existing data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The results of the data reversal are shown below, this is a tails representation of the data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



WINTAPE / WINCOMP Operator Manual 

  56 

Editing Utilities  [ WINCOMP ] 

RGB Adjustment 
The RGB adjust function is used to add color updates on all scenes beginning with the specified 
Start Scene up to and including the End Scene. The adjustment is entered as plus or minus Red, 
plus or minus Green and plus or minus Blue. The minimum and maximum allowable adjustments 
are shown. Normally scenes with zero colors are not adjusted, to override this check the Enable 
Adjust of ( 0,0,0 ) Lites Check Box. 
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The results of the RGB adjust applied to the WINCOMP view to create color updates 
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Editing Tables 

Color Samples 
Color Samples are used with the Cutbacks enabled or disabled depending on the settings of 
Setup/Preferences – CutBack Used and Use Scene Desc with Samples. 

Color Samples with Cutbacks Disabled 
 
The color samples table Display is turned on or off from the Color Samples selection on the view 
menu. Refer to Color Keys in Edit Key Reference for using color sample table. 
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Select the RGB data field of the current scene and Press F4 to add this color to the table. 
Choose the slot, one of A-N, in the table and press OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Color Samples with Cutbacks Enabled 
This is similar except the cutback is included with color in the table 
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To add a sample press F4 as in the previous section. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the color is changed in a cutback then all cutbacks will be updated. The following message 
warns that the cutback has changed and all scenes with this cutback are to be updated. Answer 
YES and the update is performed or NO and the cutback designation of the current scene is 
removed. 
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Scene Description Table 
Select the scene description field of the current scene and use CTRL 1 through CTL 0 and SHIFT 
1 through SHIFT 0 to add scene descriptions from the table to this field.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To add to the table from the current scene, select the scene description field and Press F5 then 
enter the number of the slot in the table in the dialog box shown below. 
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Data Conversion 

Creating Cynex Data 
 
Enter the parameters for creating the Cynex data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Cynex process may be performed on a single color as entered in the Manual Input section or 
on a loaded data file. The results of the Cynex process on the above sample, is shown below. 
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Creating Wedge Data 
Enter the data to define the Wedge steps and Press OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The created Wedge data for this input is shown below. 
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YCM to RGB Convert 
This function will switch YCM data to RGB data. 
The following shows the lights as YCM lights followed by the RGB conversion of these lights. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Robot to RGB Convert 
This function converts Robot light values to RGB light values. 
 
 

 


